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Welcome

Readiris is a powerful Intelligent Optical Character Recognition
(IOCR) system which transforms your PC and scanner into an
efficient page reading system.

It provides you with the best and fastest way to transform printed
and typed information into editable text files that can be used by
your wordprocessor, spreadsheet, desktop publishing software etc.

Readiris uses the familiar menus and style of the Windows
environment. The user-friendliness is such that you can even start
Readiris from within your favourite Windows applications!
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About Readiris

The Readiris software package is very easy to install and use. The
installation takes two minutes, getting started five. Its operation is
in most cases limited to clicking in the button bar.

Readiris, although being designed as a low-cost product,
nevertheless gives you access to the most advanced techniques of
artificial intelligence used in the field of IOCR (Intelligent Optical
Character Recognition).

Readiris is a self-learning system. In other words, it can learn new
characters by itself. Multiple linguistic databases, lexicons, are
used to analyze the linguistic context and thus provide a powerful
tool to find new solutions in difficult cases.

Finally, Readiris allows you to capture images from printed
documents via your scanner and import them into your graphics
application program.
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About This Manual

This manual describes how to use Readiris. The first chapter,
"Getting Started”, gives you information on the system
requirements and on the installation procedure.

The second chapter, "Quick Start", gives you a quick overview on
how Readiris works and introduces you to the basic concepts.

After that short tutorial, you may want to get more details on the
many advanced features of Readiris. This constitutes the content
of the third chapter, "Learning More About Readiris".

A full reference to the Readiris menus and their commands can be
found in the fourth chapter, "Commands Reference".

The last chapter, "More About OCR", gives a brief description of
the OCR concepts and parameters. It deals with the impact of
these different parameters on the performance of OCR systems in
general and on Readiris in patrticular.

All complementary information not included in this manual can be
found in the README.TXT file. Please read this file if you have
any trouble with the Readiris installation or its operation. For
information on scanners, consult the READSCAN.TXT file.
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1 Getting Started

This chapter tells you how to install Readiris before using it for the
first time.

It is assumed that you are familiar with your computer, the DOS
operating system and the Windows environment.

System Requirements

These are the minimal system requirements for Readiris:

B 386 based IBM PC, PS/2 or compatible PC. Multitasking is
supported, even on a 386 based PC!

Em 4 MB RAM. You may need additional memory space to use the
Connect capability.

B the MS-DOS operating system, 3.3 or later. MS-DOS 6.x is
recommended.

B a Windows 3.1 licence. Do not run Windows 3.1 in the standard
mode!

Installing Readiris

As a security measure, make a backup copy of your Readiris
diskettes and store them in a safe place.

Execute the following steps to install Readiris:
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B Be sure that you are in Windows’ Program Manager. Choose
"Run" from the "File" menu, enter a:setup in the command line
box and click "OK".

B The installation program starts running. Indicate the desired
operating language of Readiris and follow the on-screen
instructions.

You'll be asked to insert the second diskette at some point.

The program group and application icons are created by the
installation program.

Installing the Connect Capability

Readiris should be installed correctly before you install the
Connect capability.

Start Readiris, select your scanner and save the default settings
before installing the Connect capability. Refer to chapter 3,
“Learning More about Readiris", to learn how to do so.

For WordPerfect, Word and Excel, a macro must be installed by
the user if the Connect capability is to work. The on-line help
system will tell you how - the appropriate help topic is displayed
automatically when you run the Readiris installation program.

For all other Windows applications, a Connect task server has
been installed by the Readiris installation program; the user isn’'t
involved.
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2 Quick Start

The best way to see how Readiris works is to use it. The following
pages allow you to get started immediately. A pre-scanned image,
ENGLISH.TIF, is provided with your licence, so it's suitable for
training on the OCR program, even when your scanner isn't
connected yet.

Running Readiris

Be sure that you are in Windows’ Program Manager. Double-click
the Readiris icon.

Readiris
View Process

REAPIRIS

Readiris release 3.50

File Edit Preferences

1y

1994 by 55
Image Recognition Integrated
Systems SA z=r" 4
All rights reserved
Linguistic Datab by Proximity
SN: 4311193
LR.LS.

The startup screen is displayed.
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Preferences

Scanner...

Quick Sart

“Q

Text Format...
Graphics Format...

Language...

+ Toolbar

“L

Opecn...
Get Info...

Werioak Woaaran...
Acquire._ ..

Get Layout...
Sawe Layout...
Sawve Settings...
Get Scttings...

Set Default Settings
Ex<it

|English

The Readiris application window not only contains command
menus but also a button bar: clicking these buttons will suffice to
execute most actions. Click the command "Toolbar" under the
"Preferences" menu to enable and disable the button bar.

Defining your Default Configuration

Select the “Preferences” menu. The following commands
appear: “Scanner”, “Text Format”, “Graphics Format” and
“Language”.

Go through each command and select your standard settings.
Select the command “Set Default Settings” from the "File"
menu. Click "OK" to confirm.

Your system is now ready for use. Even if you have a scanner
connected, we recommend you to try the tutorial first.

Performing OCR on a Prescanned Image

This short tutorial uses a prescanned image of a text about OCR.
We'll recognize the text and save the artwork in a graphic file.

Settings

Let’s set our system up first.

Be sure that English is selected in the “Language” drop-down
list of the button bar.

In the “Preferences” menu, select the ASCII file format for
your text file with the “Text Format” command, and the
Paintbrush format for your graphics file with the command
“Graphics Format”.

Choose “Control Panel” from the “Process” menu.

(2] [«]

Check if the character size and font type are set to normal
and the character pitch to proportional.
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Process
Control Panel... “P
8
]

Ensure that the font dictionary is READIRIS.DUS and that the
dictionary is in the new mode.

Disable the "Page Analysis" in the button bar if necessary.

+ Interactive Learning

Close the Control Panel by clicking the “Close” button. Page Analysis

v Yiew after Scan

Opening the Image File

Set the “View After Scan” option in the “Process” menu.

This option is set when a check mark is present. If this is not
the case, click “View After Scan”.

Click the disk icon in the button bar to indicate the proper
input source.

Click the “Scan” button in the button bar. You now have to
select the image file. Select the prescanned image
ENGLISH.TIF installed in the Readiris directory.

Read
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The image is read from the disk and displayed progessively
on your screen. The windows toolbox is also displayed.




12 Quick Sart

= Windows

Zooming the Image

We can zoom in on parts of the image.

Put your mouse pointer over the area of the image you want
to enlarge.

Click on the right mouse button to zoom in. Clicking this
button again restores the full-size image.

You may also use the commands of the "View" menu and their
associated shortcut keys. These can even be used while moving
the mouse, which is especially useful when you are working on
pages with a complex layout.

Defining the Text and Graphic Window

The second phase is that you indicate which text blocks are of
interest to you. We will draw a text window around the text to be
recognized and a graphic window around the artwork.

Select the rectangle tool by clicking on the rectangular tool in
the windows toolbox. The mouse pointer becomes a
crossbar.

Select the window type: text.

Move the crossbar near the upper left corner of the text and
click.

Stretch the window by moving the crossbar to the right lower
corner and click again.

The text window is drawn.

Drawing a graphic window is done in the same way, the only
difference being that you select the graphic window type in the
windows toolbox.

Modifying a Window

Select the window by clicking the arrow tool in the windows
toolbox and clicking a window side.

Move the cursor to one of the markers.

Click and hold down the left mouse button.
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Move the mouse. The window is adjusted accordingly.
Release the button when the window size is correct.

Character Recognition

When your windows are correctly defined, you can exexute the
character recognition process.

Click the “OCR” button in the button bar.

At the end of the recognition phase, the program enters the
interactive learning mode. The recognized text is displayed
progressively and the system stops on doubtful characters.
The system displays the image of each doubtful character in
its context and proposes a solution.

Learn

A word about OCR The aim of OCR is to automatically enter
printed text document in a very effective and low cost way.
Although the first research and development on Optical
Character Recognition [OCR) began more than

iy

Undo Continue 0K

Confirm Delete End
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Click “OK” or press ENTER to confirm a correct proposal; key
in the right solution if the system’s proposal is wrong, then
click “OK” or press ENTER.

“Continue” allows correction without learning. Ignore the other
buttons for the moment.

(Actually there’s much more to it than that. The exact
significance of these buttons will be discussed in the next
chapter.)

Quit Readiris when you have finished.

Since the "OCR" button also serves to save graphics, the graphic
zone has been invisibly saved.

Viewing the Results

You should now have the text file READIRIS.TXT and the graphic
file READIRIS.PCX in your working directory.

Start Notepad and open READIRIS.TXT.

The recognized text is displayed on-screen. What was first a
paper document has now become an editable text file!

Quit Notepad.
Start Paintbrush and open the file READIRIS.PCX.

Windows' graphic module displays the image. You can now
edit this picture.

Performing OCR on a Paper Document

It is now assumed that you have installed your scanner correctly.

Setting up Your Scanner

Click the “Scanner” button in the button bar. The supported
scanners are listed.



Select the installed scanner model and click "OK". The
supported page formats are listed for flatbed scanners as are
the various resolutions.

For OCR purposes, select a resolution of 300 dpi. You may
use 400 dpi when the image quality is poor.

You may have to adjust the brightness and contrast setting
with the slider bar, if available.

With handy scanners, however, brightness and resolution are
set with switches on the scanner itself.

Indicate the correct input source by clicking the scanner in the
button bar.

Scanning with a Flatbed Scanner

Put your document on your scanner’s flatbed.
Select the correct scanning orientation in the button bar.

Click the “Scan” button.

The page is scanned and displayed on your screen progressively.

If the selected scanning orientation was landscape, the image will
be rotated immediately after the scanning.

Scanning with a Handy Scanner

[~ [

[«]

[+]

Select the correct scanning direction in the button bar.

Click the “Scan” button. The cursor changes into a small
handy scanner.

Place your scanner on the section of the document you want
to capture. Your document should be on a flat surface.

Press the start button of your scanner once and move it in the
selected direction.

The movement has to be slow and as steady as possible,
otherwise the scanned image may be useless for the OCR.
The image is displayed progressively as your scanner moves.

Quick Sart

15
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When you have finished scanning the image, press the space
bar to pass control to Readiris.

If the selected scanning direction was left to right or right to
left, pressing the space bar will automatically rotate the
image.

Executing Recognition

Now you can use Readiris in the same way as you did with the
prescanned image: you can zoom in to have a closer look, indicate
the zones of interest by drawing windows, execute recognition etc.



3 Learning More About
Readiris

This chapter provides many details on the extensive capabilities of
Readiris.

You will learn how to scan an image and how to control the quality
of the scanned image. When your document is correctly scanned,
you may define windows to specify which parts of the text you'd
like to be recognized by Readiris or have the system analyze your
page layout automatically. Next, Readiris starts the character
recognition and generates an output file.

We will also look into some advanced features such as automatic
recognition, the Connect capability and we will learn how to OCR
tables.

Defining Your Default Settings

First of all, you need to define your default settings. In other words,
you should specify:

W the supported scanner and its settings

m the file format for the output text and graphics
W the language of the text to be recognized

B the parameters defined with the control panel

These settings rarely need to be changed and can be stored in a
default settings file to avoid having to redefine them.
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Setting up Your Flatbed Scanner

Click the “Scanner” button in the button bar. The supported

scanners are listed.

Type Format:
Fujitsu M3094

Ch ]
ange Scanner. Cancel

Contrast 127 [ Landscape

Brightness 127

Document

Light

Select the installed flatbed scanner and click "OK". The
default resolution, page format, brightness and possibly
contrast are displayed.

Click on the document format corresponding to the pages you
normally read. A4 is the default page format.

Select your scanning resolution. The default resolution is 300
dpi.

Set the scanner’'s brightness and possibly contrast. The
middle position is the default value.

The contrast option may not be available on your scanner. The
brightness and contrast scrollbars allow you to adjust the scanning
to light and dark documents. HP scanners allow you to enable the
AutoExp option, which adjusts the scanning brightness to the
document automatically.

Readiris also supports the HP AccuPage technology. This
technology not only adjusts the scanner brightness autonomously
but also uses advanced image processing techniques to optimize
the scanned image for the recognition process.
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Format:

Type
HP AccuPage

Change Scanner... 5

0K

Cancel

[PPRHESSHRTFHIRRSISSE:

Ot ansdseaps

This technology is only available on HP scanners. Select the
AccuPage "scanner" instead of an HP scanner and click the

AccuPage option.

The technical documentation that came with your scanner
undoubtedly gives more information on its setup and operation.

The file READSCAN.TXT in your Readiris directory also contains

information on how to set up a scanner.

Setting up Your Handy Scanner

Click the “Scanner” button in the button bar. The supported

scanners are listed.

Select the installed handy scanner and click "OK". The

current resolution is displayed on-screen.

The resolution and brightness are set with switches on your

scanner.

19
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Preferences
Scanner...
Text Format...
Graphics Format...

“Q

Language...

“L

+/ Toolbar

Learning More About Readiris

. Format:
Type: oK

Handy Scanner

Change type... I

Resolution: O Landscape

The technical documentation that came with your handy scanner
undoubtedly gives more information on its setup and operation.

The file READSCAN.TXT in your Readiris directory also contains
information on how to set up a scanner.

Text Format

Choose “Text format” from the “Preferences” menu.

Ascii IBM [ 1] :
ANSI ] ='Paragraph;
<clipboard> i [ Indentation
ATF [WinWord) [+

Select the text format you intend to use.

Readiris outputs directly to a large number of wordprocessors
and text formats. Use the ASCII or ANSI format for other
wordprocessors.

Readiris also outputs tables directly to spreadsheets in a generic
table format.
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The clipboard "format" allows you to save the results directly to
the clipboard and paste them directly in your Windows application.

Two options give you the possibility to influence the appearance of
your output:

B Paragraph: enables the paragraph detection. When enabled,
Readiris respects the wordwrap typical of wordprocessors by
putting a carriage return only at the end of paragraph.

B Indentation: activates the text margin codes. This is useful if
you want to preserve the appearence of the original text. Do not
activate this feature if you intend to import your text in a desktop
publishing application!

Graphics Format

Choose “Graphics Format” from the “Preferences” menu.
Scanner...
Select the graphics format accepted by your graphics Text Format...
application program.
Language... “L
. + Toolbar
Graphics Format
TIFF 1d PackBits
TIFF Uncompressed
Mif:rosoﬂ Paint ]
PaintBrush
Readiris will save your graphics in that graphic format.
Language
It is important that the user indicates the language of the document
to be recognized correctly if the linguistic databases are to play a
positive role in the recognition process.
Click the dropdown list in the button bar or choose the -
command “Language” from the “Preferences” menu. |English

Select the language you want to recognize most often.
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Readiris is equipped with many linguistic modules which positively
influence the recognition rate!

Readiris can also be set to a numeric mode to recognize tables of
figures with maximum accuracy and speed.

Saving Default Settings

You can now store these settings in order to avoid having to
redefine them each time you run Readiris.

Choose “Save Default Settings” from the “File” menu. These
settings will be loaded each time you start up Readiris. You can
display these settings with the "Get Info" command of the "File"
menu.

Saving and Restoring Settings

In addition, you can save particular settings for other than you
basic application. These settings are saved with the “Save
Settings” and activated with the “Get Settings” commands of the
“File” menu.

Files in
cAreadiris

excel.ibt
winwordf.ibt
winwordwv.ibt
wpwin.ibt
[
—a-
-
—~d-]

—

o —
i

File Name:
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Saving Settings
Choose “Save Settings” from the “File” menu. The settings
files in your current directory are listed.

Enter a filename to save your settings to a new file or
overwrite an existing file.

Click “Save”.

Doing so stores the current Readiris configuration in the specified
file. These files have the default extension *.ibt.

Restoring Settings

Choose “Get Settings” from the “File” menu.

The settings files in your current directory are listed.
Select the correct file or select it in another directory.

Click “Get".

All about the Control Panel

Before starting the OCR process on a document, you need to
specify the characteristics of this document. These are:

B the document’s language
B the document quality

m the font type

W the character pitch and size

You can also specify if there is a font dictionary for the typeface of
the document to be read.

The Control Panel gives you the control of every parameter
needed to adjust your software to the various document types that
may be recognized. It is split up in three parts:

B Document
B Process

23



24

Learning More About Readiris

Control Panel

Document™ | rFiles
 Pitch

 Fixed

® Proportional

! Scanner

Text: [N] READIRIS.TXT

_Output | aphics: READIRIS.TIF

Default
rSize ; J
1 |N] HEADIRIS.DUS
< Small
® Normal  Process
Page([s] to Read
[ Font & Page Analysis
® Normal

B view after Scan
2 Dot Matrix & Interactive Learning Close
1 Strong Checking

B Files

Document

This part specifies the characteristics of the document to be
recognized. These are:

W the character pitch: proportional or fixed
W the character size: normal or smalll
W font type: normal or dot matrix

With a fixed pitch, all symbols of your font have the same width,
e.g. most documents produced using a typewriter.

A proportional pitch means that the size of a character depends
on its shape. An "m" will be wider than an "i". Most books and
newspapers are printed in proportional pitch.

The size is considered to be small when the point size is smaller
than 10 and when the interline spacing is too small. In this last
case, Readiris would have difficulties to correctly separate two
consecutive lines.
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ape-~descended 11+e

The user should also indicate the font type: you cannot OCR dot
matrix characters without enabling the correct parameter here. Dot
matrix characters are very degraded and very often cut up or
composed of individual dots. See the example below.

Process

Defines the processing mode of Readiris.

When the page analysis is enabled, the text and graphic blocks on
the page are detected and sorted automatically. The user avoids
having to window the scanned image manually. This is particularly
useful when columnized texts and documents with a complex page

='| Readiris
File Edit Preferences Yiew Process Help
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layout are OCRed.

Page analysis initially considers every detected block to be a text
block. Don't interfere when graphics occur on the document: in a
second phase, the software notices by itself that no characters can
be found there! (Nor will they be saved as graphics.)

The blocks are sorted from the top down and left to right by default
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to cope with columnized documents but you can change the sort
order. Click the "Sort" button in the button bar and click on a
window marker of the various windows.The windows which you do
not click on at this point will be simply ignored!

Finally, we should add that page analysis is fast, skew-tolerant and
accurate.

With the "View after Scan" option, you enable and disable the
preview. Using the preview mode means that the scanned
documents are displayed on-screen before being processed. (For
handy scanners, it is best to leave the preview enabled at all
times.)

The third parameter is interactive learning . Enables the validation
phase, where Readiris can acquire new font information. Disable
this option to run automatic OCR on a multiple page document and
when the recognition rate is excellent.

You can also influence the degree of interaction. With the option
"Strong Checking" enabled, the verification level is high: Readiris
will confront the user with even the smallest doubt instead of taking
some decisions autonomously. When Readiris recognizes a text
with great comfort, you can limit yourself to the verification of those
forms that constitute a real doubt.

Files

Here you will find all files Readiris can use during its operation.
There are four types.

Input: defines the input source - you scan a page or open a
prescanned image.

Output: defines the filename for the output and the output mode -
you replace or append a text file. Readiris can create up to two
output files: a text file and a graphic file.

Layout: determines the layout file. You start with the default, empty
layout or with a specific layout file. Layouts are windowing
configurations, they contain the windows structure you defined
during the document preview. After the manual windowing and
page analysis by the system, layouts constitute the third method of
indicating the zones of interest.

Dico: defines the font dictionary and mode.
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These font or user dictionaries contain font information on the
characters you train the system on during the validation phase.

Three dictionary modes are available:

B New: you create a new font dictionary, you start without any
previously learnt knowledge.

B Append: you make use of previously built up font knowledge
and complete it.

B Read: you make use of previously learnt knowledge but don’t
store new information in it.

It is imperative to use font dictionaries efficiently to obtain an
accurate and fast recognition of your documents. Doing so implies
that you select the correct mode for the dictionaries.

If you have only one page to be recognized, select the mode new.
However, if you have many pages of the same type - meaning
documents with the same typeface and printing quality - you
should select the mode new for the first page, the append mode for
the second and third pages, and the read mode for the rest of your
pages.

Saving to the same user dictionary all the time doesn't make any
sense: the size of these files is limited!

Scanning a Page with a Flatbed Scanner

Select the correct scanning orientation in the button bar. (You
can also enable the "Landscape" option by clicking the
"Scanner" button in the button bar.)

Click the "Scan" button.

The document is scanned immediately. When the preview is
enabled, the image is displayed on-screen progressively.

If the selected scanning orientation was landscape, the image is
rotated directly. You can also rotate images afterwards with the
"Rotate” command under the "View" menu.

Pay some attention to lineskew. Although page analysis and
recognition by Readiris are skew-tolerant, it may become difficult to
window and OCR a scanned page correctly when the lineskew is
too significant.

27
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Click the "Scanner" button to modify the scanner’s settings such as
resolution, page format etc.

Scanning a Page with a Handy Scanner

6]

When you have activated every parameter necessary, you are
ready to scan your document.

Select the correct scanning direction in the button bar.

Click the "Scan" button in the button bar. The cursor changes
into a small handy scanner.

Brightness and resolution are set wtih switches on your handy
scanner. Use a resolution of 300 dpi for high-quality
documents, select 400 dpi if the image quality is poor.

Place your scanner on the section of the document you want
to recognize.

Press the start button of your scanner once and move it in the
selected direction.

The image is displayed progressively as your scanner moves
about.

The movement has to be slow and as steady as possible,
otherwise the scanned image may be useless for the OCR.

The manufacturer’s instructions that came with your scanner
can undoubtedly give you more information on how to operate
your scanner.

When you have finished scanning the image, press the space
bar to pass control to Readiris.

If the selected scanning direction was left to right or vice versa,
pressing the space bar will rotate the image directly. You can also
rotate images afterwards with the "Rotate” command under the
"View" menu.

Pay some attention to lineskew. Although page analysis and
recognition by Readiris are skew-tolerant, it may become difficult to
window and OCR a scanned page correctly when the lineskew is
too significant.
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Taking a Closer Look at the Scanned Image

Displaying the entire page at once is convenient for seeing the text
and graphic blocks as they relate to each other. This full-page view
is called “Fit in Window".

To control the scanning quality of the document, you must take a
closer look. Readiris gives you three other views:

B Actual Size: approximates the page size as it is printed
B 50% Actual Size: displays at half the actual size
B 200% Actual Size: displays at twice the actual size

You can also switch from the “Actual Size” to “Fit in Window” and
vice versa by clicking the right mouse button.

Controlling the Scanned Image Quality

The performance of the optical character recognition depends
greatly on the quality of your document and scanning. Taking a
closer look at the scanned image is useful in controlling this
quality.

Readiris will produce the best results on a document of “good"
quality, e.g. documents where the characters are well formed and
reasonably well separated.

On a document which is too light, characters are sometimes cut
into two parts: an "O" may become "()". On the other hand, a
document which is too dark will contain letters with very large
shapes, and opened letters may be closed when scanned: a "c"
becomes an "0", for example. On a dark document, many
characters may be glued together, preventing good recognition.

You can enhance the quality of the scanned image by adjusting
the brightness and contrast of your scanner.

Once the image has been rescanned, you can verify the changes
on your screen.

Yiew

+ Fit in Window
50% Actual size
Actual Size
200% Actual Size

W
“b
1
2
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= Windows

YWindows

Windowing Tools

When the document is displayed, the next step is to indicate the
zones of interest.

There are several ways of doing so: page analysis automatically
detects and sorts the various blocks. You can modify the resulting
layout with the "Sort" button. The other way is manually defining
the windows. Thirdly, you can save specific windowing structures,
so-called "layouts", in files for future use.

Drawing or detecting several windows is mandatory whenever a
text is arranged in columns. To recognize tables correctly, draw
windows around each column to neatly arrange the output in table
cells.

Here’s a description of the Readiris windowing tools.

Creating a Rectangular Window

Select the rectangle tool by clicking on the rectangular tool in
the windows toolbox.

Select the window type: text or graphics.

Move the cursor to a corner of the window you want to create
and click.

Stretch the window by moving the cursor to the opposite
corner and click.

The window is drawn.

Sides smaller than 1 mm are not allowed!

Creating a Polygonal Window

Select the polygon tool by clicking on the polygonal tool in the
windows toolbox.

Move the cursor to a corner of the polygonal window you
want to create and click.

Move the cursor. One side of the polygon is drawn as your

the mouse.
Click to fix the first side.

[+]
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Move the cursor and click where ever you want to terminate a
polygon side.

[6] Click on the right mouse button to close the polygon.

You can't cross a side you've already drawn!

You can also create polygons by merging rectangles. Whenever
two windows of the same type touch, they are merged to form a
single window.

Selecting Windows

Select the arrow tool in the windows toolbox.
Click on a window border.

31

Markers appears at each corner and in the middle of the
window sides.

To select a second window without unselecting the first one,
hold down the Shift key while clicking on this second window.

To select one window and every window included in it, hold
down the Ctrl key while clicking on the main window.

To unselect windows, click the mousebutton anywhere but
the on the window sides.

You can display the type and coordinates of a window by pressing
the Alt key while you select the window.

Modifying a Window

Select the window. See above.
Move the cursor to one of the markers.

Click and hold down the mouse button.

(2] [o] [ 5]

Move the mouse.

The window size changes accordingly to your moves.

Release the button when the window size is correct.

[}



32 Learning More About Readiris

Undo Alt+BkSp

Delete  Sh Del
Copy  “Ins
Pastt  Shlns

SelectAll “A

Moving Windows

]

[ [

[}

Select the window(s). See above.

Move the cursor to a window side, midway between two
markers.

Click and hold down the mouse button.

Move the mouse. The window position changes accordingly
to your moves.

Release the button when the window position is correct.

Deleting Windows

Select the window(s). See above.

Choose the “Delete” or “Clear” command from the "Edit"
menu.

The "Delete" command erases the window(s) but saves an
internal copy that you can paste later on. "Clear" erase your
window(s) irretrievably.

Character Recognition

Click the "OCR" button in the button bar to execute the character
recognition on the zones you have indicated, even when you only
want to save graphics.

The progress is indicated; you may interrupt any time by clicking
the "Stop" button.
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IOCH phase

As Readiris supports multitasking, you may also run the
recognition in the background. Minimize the Readiris window and
perform another task on your PC; the interactive learning window
will pop up when the software is ready.

During that interactive phase, the recognized text is displayed
progressively. When the system is unsure about a solution, the
image of the word is displayed and the doubtful character is
highlighted. The system stops and waits for your response. See
below.

After the validation phase, the recognized text is saved in the
output file or in the clipboard and you are asked if you want to read
another page.

251 characters in output file
CAREADIRIS.TXT

Next page

In case of multiple-page document, the "Next Page" button
automatically puts the font dictionary and output file in the append
mode. With a flatbed scanner, the next page is scanned, with a
handy scanner, you are ready to scan again.

You will easily find that the learning phase requires much less
interaction for the next pages, when the font is similar.

33
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Learning Fonts

The last step of the recognition is the learning phase. (The degree
of interaction is dependant on the option "Strong Checking" in the
"Control Panel".)

If Readiris is unsure about a recognition result, the doubtful form is
displayed with its parent word. The character - or string of
characters if they aren’t separated - is highlighted and the
proposed solution is presented. Unrecognized characters are

signalled as "~".

Learn

A word about OCR The aim of OCR is to automatically enter
printed text document in a very effective and low cost way.
Although the first research and development on Optical
Character Recognition [OCR) began more than i

1x®,

‘ Undo ‘ Continue 0K

‘ Confirm ‘ Delete End

If necessary, key in the valid characters and select one of the
following buttons.

OK

You agree with or correct the proposed solution. The result is
stored in the font dictionary as certain, final: future recognition of
the same form will no longer require your intervention.

Alternative: press ENTER.
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Continue

You agree with or correct the proposed solution. The difference
with "OK" is that Readiris stores the result as “unsure” information
in the font dictionary. Future recognition of the same form will still
require your intervention.

Use this command for damaged characters which could be
confused with other characters if OKed.

Confirm

The number '1’" and letter “I” have an identical form in many
typefaces. In this case, Readiris performs a context analysis to
discirminate them. Where the context does not suffice, the user
has to decide.

Use this button when the shapes for the number '1’ and the letter
“I'" are clearly different, otherwise use "Continue".

Undo

Allows to go back, correct mistakes. Readiris keeps track of the
last nine operations!

Delete

Deletes characters from the output. Use this button to prevent
spots on your document from being recognized as periods,
comma’s etc.

End

Aborts the interactive learning process. The decision phase will be
completed automatically. You accept every solution of Readiris.
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Making Good Use of Font Dictionaries

If you run Readiris on many documents of the same type, you may
not want to repeat the same learning process every time. For this
reason, you can store learnt characters in a font dictionary and use
that acquired intelligence when you want to OCR similar
documents.

To create or activate a font dictionary:
Choose “Control Panel” from the “Process” menu.
Click on “Dico”.

All font dictionaries in your current directory are listed. They
have the default extension *.dus.

Files in
c:\readiris

mangazine.dus
readiris.dus

el

| Cancel I | OK I

' New Dictionarny
- Append Dictionary
 Read Dictionary

File Mame:

|*.dus |

Enter a name to create a new font dictionary or select an
existing one.

Click on one of the available modes: "New” to start a new font
dictionary, "Append” to complete an existing dictionary and
"Read” to use a font dictionary without storing new
information in it.

Click “OK”.

The active dictionary file is displayed next to the “Dico” button in
the “Control Panel”. The selected mode is indicated between
parentheses.
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Getting Help

This concludes our general overview of the operation of Readiris.
Readiris contains an on-line help system that extensively
documents every aspect of the software. The on-line help may also
contain some last-minute information.

Select the command "Contents" under the "Help" menu to access
that information. Shortcut: press F1. "About Readiris" displays the
initial screen with your registration data.

However, Readiris contains some advanced features which we
still should discuss in detail. We’'ll explain how to recognize tables,
how to execute automatic OCR and how to use the Connect
capability.

Recognizing Tables

You can use Readiris to import tables of figures directly into your
spreadsheet.

Drawing a window around each column is mandatory to neatly
arrange the output in corresponding cells, otherwise you won't be
able to import the tables correctly. The illustration below gives a
good example.

Readiris
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Control Panel... ‘P

Scan 5
GOE 3

Interactive Learning

v Page Analysis
View after Scan

Select one of the two following text formats: Excel ASCII or Excel
clipboard. Although both provide a generic table filter, the Excel
ASCII format creates a table file that can be imported directly in
your spreadsheet while the Excel clipboard format sends the
recognized table to the Windows clipboard. Use the "Paste"
command of your spreadsheet to insert the table.

Detection of paragraphs and indentation is disabled whenever you
select a table format.

Readiris can limit recognition to a numeric character set when
tables of figures which contain no text are OCRed. Select the
numeric mode in the "Language" dropdown list of the button bar.

Automatic Recognition

You can make the recognition of your pages automatic. How
automatic the recognition is executed depends on the scanner

type.

Flatbed scanners allow fully automatic recognition of a large
number of pages. Disable the options "Interactive Learning" and
"View after Scan" and enable the option "Page Analysis". (You
may also use a windowing layout to indicate the zones of interest.)
Enter the number of pages to recognize in the "Control Panel".

Put a stack of pages in the scanner's document feeder, click the
"Scan" button to start scanning and let your PC do the rest. The
document stack is scanned, zoned and recognized without any
intervention on your behalf! If the document feeder gets empty
before the specified number of pages is recognized, an error
message pops up.

Things are somewhat different for handy scanners. As the
scanning always takes some physical effort on the part of the user,
recognition is never fully automatic. Nevertheless, you can make
automatic the windowing and recognition phases.

As automatic recognition implies that the interactive learning phase
is disabled, it may be recommended to train Readiris on a few
pages first; otherwise, your output may not show an optimal
recognition rate.
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Using the Connect Capability

The Connect capability offers a direct OCR link between your
scanner and your Windows application. You are indeed able to
OCR texts from within your favourite Windows application!

A new command appears in the menus of your Windows
application after the installation of the Connect feature. Click on it
and Readiris starts running. You scan and recognize your
document and the output is inserted directly in your Windows
application, at the current cursor position.

WordPerfect, Word and Excel
Make sure that Readiris does not run in the background.

Click on the new command "Scan Text" in your application menu
to run Readiris from within your Windows application. For
WordPerfect 5.x, this command appears in the "Macro" menu, for
WordPerfect 6.0 under the command “"Macro" of the "Tools" menu
and for Word and Excel in the "File" menu.

The Connect interface may ask you some questions before
Readiris starts running. Proceed as usual and quit the Connect
interface when you are through. The recognition results are
inserted at the current cursor position.

Other Windows applications

Double-click the Connect icon to run the Connect task server in the
background before you run your Windows application. Click on the
new command "OCR" in the "File" menu of your application. A
dialog box appears.

Indicate if you are going to read a body text ("Text") or a table of
figures ("Spreadsheet"). Select "Full Page" to enable page analysis
or select "Partial" to window the scanned document manually.

Enable the option "Verify Text" to include the interactive learning
phase. The user validation is by default disabled.
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= OCR Options
® Ten
s d<h
— Cancel g
Oa Yerify Text
® Full Page
O Partial

The "Configure" button gives access to some advanced
parameters. Select "Simulate keystrokes" to insert the recognized
text as if keyed in on the keyboard or select "Paste Clipboard" to
paste the text invisibly from the clipboard.

@ Paste Clipboard with: %ep|

O Simulate keystrokes

Check if the correct shortcut key is specified for the paste
command of your Windows application.

Some keys are represented by a special character.

KEY REPRESENTATION
Shift +

Ctrl A

Alt %

Insert {INSERT}

Some examples: when the shortcut key for the Paste command is
CTRL+V, you should enter *V here, when the shortcut key is
SHIFT+INSERT you should enter +{INSERT} etc.
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4 Commands Reference

This chapter is a short reference guide of all the Readiris menus.
You are undoubtedly familiar with these commands if you have
studied the previous chapters.

File
Gives you the possibility to save and retrieve settings and Eile
i i 1 H Open...

windowing files. Allows you to open a prescanned image. P
Lelest Bouree.
Acquire...
Get Layout...

Open Save Layout...
Save Settings...

. . . . . Get Settings...

Opens a TIFF format image file. Active only in the preview mode. Set Default Settings
Exit

Get Info

Displays the active Readiris configuration.

Select Source

Readiris being compliant with the Twain scanner standard, this
command allows to select a Twain scanner and set the scanning
parameters.
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Acquire

Starts the scanning. Equivalent to the command "Scan" in the
"Process" menu and the "Scan" button in the button bar and the
"Control Panel".

Save Layout

Saves the windowing structure as defined on a document during its
preview. Layouts are saved in a file with the default extension
.wdw. Active only in the preview mode.

Get Layout

Recovers the windows structure previously stored in a file with the
default extension .wdw. Active only in the preview mode.

Save Settings

Saves the current Readiris configuration in a file with the default
extension .ibt.

Get Settings

Recovers the Readiris configuration previously stored in a
configuration file.

Set Default Settings

Stores the current configuration as the default for the Readiris
startup.

Exit

Quits the Readiris session.
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Edit

The commands of this menu are only active during the document
preview: they act on windows defined when the document is
displayed on-screen.

To select a window, click on a window side. If more windows are to
be selected simultaneously, hold down the Shift key while you click
on the window sides.

Undo

Cancels the previous command.

Delete

Deletes the selected windows but saves them in an internal buffer.

Copy

Copies the selected windows to an internal buffer.

Paste

Inserts the content of the internal buffer. The inserted windows
appear where they were originally copied or deleted from. To move
them, click on the side of one of them and drag the mouse: the
windows move with your mouse displacements.

Clear

Deletes all the selected windows irretrievably.

Select All

Selects all windows simultaneously.
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Preferences
Scanner...

Text Format...
Graphics Format...

Commands Reference

Language...

L

Toolbar

Preferences

Specifies the basic settings of Readiris: which text and graphic
format you use and which is the language of the document to be
read. Enables the button bar.

Scanner

Displays the scanner type and his settings.

Text Format

Selects the file format for the recognized characters.

Enables the paragraph detection and margins coding. When you
recognize tables, be sure to select the Excel format.

Graphics Format

Selects a graphic format for your graphic zones. Check which file
formats your graphics application can read.

Language

Selection of the document’s language. Readiris has numerous
linguistic databases. You can also limit the character recognition to
numeric characters, e.g. to recognize numeric tables which contain
no text with maximum precision and speed.

Toolbar

Enables the button bar. The button bar is displayed on the left side
of the application window. Using the button bar is recommended
as buttons provide fast access to the most frequent menu
functions.
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View
The commands of this menu are only available during the View
document preview. vEitin Windaw "W
50% Actual size *h
Actual Size *1
L. . 200% Actual Size *2
Fit in Window 7 8l Windowes
Selected Type
Adjusts the zoom level so that the document image fits your screen Jsmi vi "'f'
. ort Yiew
size. Sort Reset
Rotate... “R
. Taoton..
50% ACtual Slze Coordinates... “C

Zooms 50%.

Actual Size

Zooms at the real size of the document: a screen pixel equals an
image pixel. You can switch from the “Actual Size” to the “Fit in
Window” view and vice versa by clicking the right mouse button.

200% Actual Size

Zooms 200%.

All Windows

Displays all windows defined on your document layout.

Selected Type

Displays the windows of the selected window type only.

Sort

Sorts the text windows. The sort order determines in which order
the different text windows have to appear in the output. This
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feature is very useful for multi-column documents. Click on a
window border to define the sort order of the various text blocks.

Sort View

Displays the logical sequence of windows as defined in the sort
command. Arrows join the different text windows.

Sort Reset

Resets the sort order of the text windows. Alternative: use the
"Sort" button in the button bar.

Rotate

Rotates the scanned image. Select clockwise or counterclockwise
rotation of the image. We recommend you to scan with the correct
scanning direction.

Toolbox

Viewing of the windows toolbox which allows you to select the
window type (text or graphics) and the window tool (rectangle,
polygon or arrow).

Coordinates

Displays the coordinates window. The coordinates of the cursor
are displayed in document pixels.

Process

Contains the commands related to the actual OCR process:
scanning, OCRing and all parameters concerning those
operations.
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Control Panel

Displays the Control Panel.

Scan

Starts the scanning of a document or opens a prescanned image,
dependent on the selective input source. Equivalent to the “Scan”
button in the button bar.

OCR

Starts the character recognition and saves the graphics. Equivalent
to the “OCR” button in the button bar.

Interactive Learning

Enables the interactive learning. Determines whether you will
check the doubtful characters or accept the system’s solutions.
(The option "Strong Checking" in the "Control Panel" determines
the degree of verification by the user.)

The learning mode is also accessible on the button bar. Disable
this option to execute automatic OCR.

Page Analysis

Enables the page analysis. Determines whether the scanning is
followed by the automatic page decomposition.

You can also enable and disable the page analysis in the button
bar. Enable this option to execute automatic OCR.

View after Scan

Activates the preview mode: the scanned document is displayed
on-screen. So you can define the different text parts to be
recognized and the graphics to be extracted by Readiris. Disabling
the preview mode doesn’t make much sense with handy scanners.

Process
Control Panel...

Scan
GOR
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Control Panel

The Control Panel specifications are described at great length in
chapter 3, "Learning More About Readiris".

Pitch

Selects the character pitch: fixed or proportional.

Size

Selects the character size: small or normal. A character is said to
be “small” if its point size is smaller than 10 or if the software has
difficulties to correctly separate two adjacent lines.

Font

Indicate the printing quality of your text: you read "normal” fonts or
dot matrix printed texts.

Page(s) to Read

Number of pages to read automatically. This option is not available
with handheld scanners.

Page Analysis

Enables the page analysis. Determines whether the scanning is
followed by the automatic page decomposition.

You can also enable the page analysis in the button bar. Enable
this option to execute automatic OCR.

View after Scan

Activates the preview mode. Equivalent to "View After Scan” in the
“Process” menu.
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Interactive Learning

Enables the interactive learning. Determines whether you will
check the doubtful characters or accept the system’s solutions.

The learning mode is also accessible on the button bar. Disable
this option to execute automatic OCR. You can also influence the
degree of interaction with the next option.

Strong Checking

When this option is enabled, the "rejection" degree is high:
Readiris will confront the user with even the smallest doubt instead
of taking some decisions autonomously. When Readiris
recognizes a text with ease, you can limit yourself to the
verification of those forms that constitute a real doubt.

Input
Selects the input source. You perform OCR either from the

scanner or from a prescanned image file. Equivalent to the input
source buttons in the button bar.

Output
Defines the output filename. If this file already exists, you have to
select the replace or append mode. The extension of the output file

is added automatically on the basis of the output format you have
selected.

Layout

Selects the layout file which contains the windows structure
adapted to a document type. The default extension is .wdw.

Dico

Selects the font dictionary and its mode: new to create a new font
dictionary, append to complete an existing dictionary and read to
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use but not write to a font dictionary. By default, the file extension
is .dus.

Scan

Starts the scanning. Equivalent to the "Scan" button on the button
bar.

Close

Closes the Control Panel.

Help Menu

This menu contains the on-line help system and the "About"
window.

Contents
About Readiris...

Contents

Gives access to the on-line help system that extensively
documents every aspect of the software. The on-line help may also
contain some last-minute information.

Shortcut: press F1.

The information can be consulted on-screen and printed out! Your
Windows manual can tell you how.

About Readiris

Displays the initial screen with your registration data.
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5 More About OCR

The aim of OCR is to automatically enter printed and typed
documents in a very effective and low-cost way. Although the first
research and development on Optical Character Recognition
(OCR) began more than 20 years ago, this technology is still
unknown by most of the people who could, and should, use it for
their document entry applications.

You can install this useful tool in your office to unburden yourself
with the fastidious task of retyping printed text.

OCR systems work well on many document types, but not all...
The following pages briefly describe the different steps in the OCR
process of a document. At the same time, an overview of the
Readiris specifications is given.

The OCR Process

The document is read by your scanner. This electronic device acts
as the “eye” of your computer and sends it the image. At this step,
the document image is only a meaningless cloud of black points,
so-called "pixels", on a white background. The OCR software has
to extract text information from these pixels: it has to recognize
shapes and assign a symbol.

There are two types of OCR systems: “automatic” and “learning”
systems. The first type can automatically recognize text from a
wide range of fonts... but not all. With the second type, you must
teach the system new characters every time you deal with a new
document set. This method requires more user interaction, but it
can treat nearly all fonts.
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Both types of OCR systems use equivalent processes to recognize
text. The main steps are:

W line segmentation

W words and characters segmentation
W character recognition

B text output

The line segmentation consists of slicing a page of text into its
different lines. This step also analyses lineskew and interspacing.
The most difficult documents are those which have both a small
interline spacing and a significant skew.

The words and characters segmentation isolates one word from
another and then separates the different letters present in each
word. If the characters are all of the same width (fixed fonts), this
step is very easy to perform. This happens e.g. on documents
printed with a typewriter.

The problem is more interesting if all letters have a width which
depends on their actual shape (proportional fonts). The most
difficult cases are found in documents where proportional
characters randomly touch. Dot matrix characters are composed of
little dots and require highly specific segmentation techniques.

The character recognition phase extracts characteristics out of
each isolated shape and gives it a name.

The text output is the conversion of the recognized text into a file
which can be imported in your wordprocessor, spreadsheet,
desktop publishing software etc.

Readiris Scope

Readiris is a high-performance but easy-to-use OCR package. Its
functions have been selected from all the high-end IOCR
technigues mastered by IRIS. This product has the following
specifications:
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B It makes use of self-learning techniques in order to be an
open system. Readiris is a learning system which appears to be
automatic: the software finds the right solution for the major part
of the document by itself.

W It extensively uses the linguistic context to find its solutions,
however it also can work without any context, like on numeric
tables for example.

W It guides the user with great comfort through a single five-step
process: scanning, preview, windowing, recognition and
validation of the doubtful results.

Like any OCR product, Readiris can not deal with every document
type, but what it does, it does well. This reliable and cost-effective
system is intended to read original documents and/or good quality
copies.

The learning capabilities are very powerful and give the best
results if the following conditions are satisfied.

Amount of Characters and Linguistic Context

Readiris needs a reasonable amount of characters and linguistics
context for each represented symbol in order to perform the
auto-learn process in such a way that recognition is mostly
automatic.

If the linguistics context is poor or doesn't exist, the system will still
work but will prompt the user for more interaction.

Character Isolation

Readiris performs a limited segmentation algorithm so as to reduce
the processing time and memory requirements.

The first step of character isolation can be performed on
reasonably separated characters. In a second step, Readiris uses
a very powerful algorithm in order to decompose groups of kerned
characters and random ligatures.

Assuming this, it needs to have been able to isolate a minimum of
elementary models (the isolated characters) to perform a correct
segmentation of touching characters.

53



54

More About OCR

The immediate consequence of this technique is that recognition of
any font is possible if the system manages to isolate a sufficient
number of elementary characters.

Character Size Range

The size range is 8 to 20 points, which covers most of font sizes
used for current text body. However, even smaller fonts may be
legible too if you select a resolution of 400 dpi.

It's suggested not to mix a title of a few words in a larger typeface
with the much bigger part of the current text to be recognized. In
most cases, the DTP operator will key in his own titles anyway.

Excluded Documents

Readiris will not read text which is too dense, i.e. where nearly all
letters in each word are touching. This is the reason for the
exclusion of low quality documents of the very dark, fat photocopy

type.
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